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EVAL-M1-IM828-A user guide

Modular application design kit (MADK) of IM828-XCC

About this document

Scope and purpose

This user guide provides an overview of the evaluation board EVAL-M1-IM828-A including its main features, key
data, pin assignments and mechanical dimensions.

EVAL-M1-IM828-A is a power evaluation board from the MADK including M1 connector and one CIPOS™ Maxi
1200 V three-phase module for motor drive applications. In combination with either EVAL-M1-101T or other
control boards with compatible M1 connectors, it features and demonstrates Infineon’s CIPOS™ Maxi IPM
technology for motor drives.

The evaluation board EVAL-M1-IM828-A was developed to support customers during their first steps designing
applications with IM828-XCC CIPOS™ Maxi power modules.

Intended audience

This user guide is intended for all technical specialists who know motor control, middle- and low-power
electronics converters. The board is intended to be used under laboratory conditions.

Evaluation Board

This board will be used during design-in, for evaluation and measurement of characteristics, and proof of data
sheet specifications.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.
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Important notice

Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards
has been tested by Infineon Technologies only as described in this document. The design is not qualified
in terms of safety requirements, manufacturing and operation over the entire operating temperature
range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems.

Table1 Safety precautions

Warning: The DC link potential of this board is up to 800 Voc. When measuring voltage
waveforms by oscilloscope, high voltage differential probes must be used. Failure to do
so may result in personal injury or death.

Warning: The evaluation board contains DC bus capacitors which take time to
discharge after removal of the main supply. Before working on the drive system, wait
five minutes for capacitors to discharge to safe voltage levels. Failure to do so may
result in personal injury or death. Darkened display LEDs are not an indication that
capacitors have discharged to safe voltage levels.

Warning: The evaluation board is connected to the grid input during testing. Hence,
high-voltage differential probes must be used when measuring voltage waveforms by
oscilloscope. Failure to do so may result in personal injury or death. Darkened display
LEDs are not an indication that capacitors have discharged to safe voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation board is shipped with packing materials that need to be
removed prior to installation. Failure to remove all packing materials that are
unnecessary for system installation may result in overheating or abnormal operating
conditions.

>R BB
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1 The board at a glance
The EVAL-M1-IM828-A evaluation board is a part of the IMOTION™ MADK for motor control (iMOTION™ MADK).

The MADK platform is intended for use in various power stages with different control boards. These boards can
easily be interfaced through the 20-pin iMOTION™ MADK-M1 interface connector.

This evaluation board is designed to give comprehensible solution for the power section featuring by CIPOS™
IPM. It provides a DC input and 3-phase output for power motor. It contains a single shunt for current sensing
and a voltage divider for DC-link voltage measurement.

The EVAL-M1-IM828-A evaluation board is available from Infineon. The features of this board are described in
the design feature chapter of this document (UG-2020-27), whereas the remaining paragraphs provide
information to enable the customers to copy, modify and qualify the design for production according to their
own specific requirements.

The evaluation boards are not subject to the same procedures as regular products regarding returned material
analysis (RMA), process change notification (PCN) and product discontinuation (PD). Evaluation boards are
intended to be used under laboratory conditions by technical specialists only.

1.1 Delivery content

The EVAL-M1-IM828-A evaluation board is designed to provide an ease-of-use power stage based on the
Infineon's CIPOS™ Maxi intelligent power module (IM828-XCC IPM).

The delivery includes the finished board as shown in Figure 1 and Figure 2. It provides a 3-phase AC connector,
an EMI filter and soft power-up circuit, input rectifier, DC bus capacitors and 3-phase output for connecting the
motor.

It also contains quasi-resonant PWM controller and CoolSiC™ MOSFET based aux power supply to provide 15V
& 3.3V, asingle shunt for current sensing and over-current protection, and a voltage divider for DC-link voltage
measurement. The board shown here can be operated directly with the required power supply without the
need for additional components.

1.2 Block diagram

The block diagram of the EVAL-M1-IM828-A is depicted in Figure 1.

IM-828-XCC

£31 L] [

ok ok Joi

uiviw =
output

| | ot Jot JE}/

—

rJ7 e s UNW PWM
3 ITRIP OTP
Control

‘ 20-PIN M1 interface <|
Feedback signal

Figurel Block diagram of the EVAL-M1-IM828-A
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Figure 2 points out the functional groups on the top side of the EVAL-M1-IM828-A design.

1) J1,AC/DCinput

2) Rectifier and soft start
3) EMCLPF

4) DC capacitor

5) Aux power

6) CIPOS MaxiIPM

7) Current sensing

8) Fan power

9) J2 M1 connector

10) J3 U/V/W output

Figure 2 Functional groups of the EVAL-M1-1IM828-A reference design

1.3 Main features
The evaluation board characteristics include:

e Nominal input voltage 3-phase 380 VAC

e Design for 8 kW motor power output

e On-board EMI filter

¢ Single shunt for current sensing

e Sensing of DC-link voltage

e Measurement test points compatible to standard oscilloscope probes
e PCBsizeis 140 mm x 151 mm, two layers with 70 um copper each

e RoHS compliant

1.4 Board parameters and technical data

Table 2 depicts the important specifications of the evaluation board EVAL-M1-IM828-A.

Table 2 EVAL-M1-IM828-A board specifications
Parameter Symbol | Conditions [ comments Value Unit
Input
Input voltage Vac Optimized design for 3-phase 380 Vac or 320~480 Vrms AC v
DCinput. /420~720V DC
Lower AC input, less motor power output
Input current Iac(max) Input 3-phase AC 380 Vs, 8 KW output, 20 Arms
T,=25°C
User guide 6 of 39 V1.0
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Parameter Symbol | Conditions [ comments Value Unit
Output
Power (3 phases) Pinmax) Input AC 380V, Frwm=6 kHz, T,=25°C, Tcase= | 8000 W
100°C
Current per phase Imtrmaxy | INput AC 380 Vac, FPwm=6 kHz, T,=25°C, 15 Arms/19 Arms (low | Arms
Tease= 100°C speed)’'
DC bus voltage
Maximum DC bus voltage | Vocmay | DC bus capacitors are 450V, 47T0uF X2 X2 | 780 v
Minimum DC bus voltage | Vocmin) | Aux power supply’s brown-in voltage 150 v
Current feedback
Shunt resistance ‘ Rsh ‘ Two piece of 10 mQ shunts in parallel 5 mQ
Protections
Motor current protection | lip: Wizard setup for OC trigger level, related | 277 Apeak
trigger level 1 to shunt resistor RS1 & RS2 and current
sensing bias
Motor current protection | lip Hardware comparator over-current 27 Apeak
trigger level 2 protection, related to shunt resistor and
LM393’s setup
Thermal protection level | Tpotection | Users need to consider the temperature 100 °C
gap by NTC sensor; it is recommended to
set temperature at 105°C or less
Auxiliary power supply 1-15V
Output voltage Voutr Used for IPM, 12V fan and relay (K1) drive | 15+5% v
Maximum output current | loua 300 mA
Auxiliary power supply2-3.3V
Output voltage Vout2 Used for IMC controller and protection 3.3+5% v
circuits
Maximum output current | loue 150 mA
PCB characteristics
Dimension Length x width x height 140x151x72 mm
Material FR4, 1.6 mm thickness, 2 oz. PCB
System environment
Ambient temperature Ta Non-condensing, maximum RH of 75% 0~50 °C

Note:

1. AsIPM and rectifier bridge are mounted on the same heat sink, IPM output capability is impacted by rectifier

For iMOTION™ IC IMCxxx, there are three types of Gatekill input source options in MCEWizard setup: Gatekill-pin,

Comparator and Both. If you select “comparator” mode, the external Gatekill signal will be not used, and the
signal |_Shunt will be compared by the internal comparator with the “Device over-current trigger level setting”

bridge’s power loss.
2.

value set in MCEWizard.
User guide
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2 System and functional description

2.1 Getting started with EVAL-M1-IM828-A

In order to run the motor system, a combination of the iIMOTION™ MADK power board (EVAL-M1-IM828-A) and
the matching MADK control board (EVAL-M1-101T or other control board) are required. This chapter provides
more details on setting up the system and getting started with the IMOTION™ MADK development platform.

The EVAL-M1-IM828-A reference designs are tested with EVAL-M1-101T controller boards, which shipped with
embedded firmware and default parameters.

Figure 3 shows the basic system connection using EVAL-M1-IM828-A to run an 8 kW GK6081-6AC31 motor with
MCEDesigner.

To Earth =

AC or DC
input

EVAL-M1-101

ToPC

.......

Figure 3 System connection example

2.1.1 iMOTION™ control board

1. If you want to use the Infineon control board, please go to the Infineon website, www.infineon.com/MADK,
and order EVAL-M1-101T.

2. Then get the latest “IMC101T-T038 MCE Software Package” available on the website,
www.infineon.com/imotion-software

3. After you have obtained the control board and software, you are ready to connect your PC to EVAL-M1-101T
via USB cable, and to program and tune the control board.

4. Connect EVAL-M1-101T’s M1 20-pin interface connector (J2) to power board (for example EVAL-M1-IM828-A,
see Figure 5).

5. Use MCEWizard to enter the target motor’s system and operating parameters, as well as the evaluation
board’s hardware parameters, which will then be used to calculate the controller’s set digital parameters

User guide 80of39 V1.0
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representing the complete motor drive system. First click the “Calculate” button on the “Verify & Save Page”
and then save the drive parameter set into your project directory by clicking “Export to Designer file (.txt)”.
The saved drive system parameter file will be later used by the MCEDesigner. Refer to Chapter 2.1.4 or
MCEWizard user guide for more details.

6. Connect motor phase outputs to the motor.

7. Connect 3-phase AC 380V or DC power to power input connector and power-on system.

8. Start MCEDesigner tool and open MCEDesigner default configuration file (.irc) for IMC101T-T038 controller
(IMC101T_Vxxx.irc) by clicking “File” > “Open”. IMC101T_Vxxx.irc file is included in the “IMC101T-T038 MCE
Software Package” downloaded in step 2.

9. MCEDesigner should automatically connect to the EVAL-M1-101T control board using default COM port
(indicated by green circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI). If it
cannot establish the connection, change the COM port as follows: (“System” window active) > Preferences >
Connection > Connect using (select one of the other available COM ports from the drop-down menu).

10. Use the following steps to program the system parameters into the internal SRAM of iMOTION™ IC: Click
“Tools” > “Programmer” and select “Program Parameters.” Browse and select the System Drive
Parameters .txt file created in step 5. See Chapter 2.1.4 for more details.

11. Start the motor by clicking the green traffic light button in the control bar.

12. Stop the motor by clicking the red traffic light button in the control bar.

2.1.2 iMOTION™ development tools and software

The iIMOTION™ development tool installers for MCEDesigner and MCEWizard are available for download via
Infineon iIMOTION™ website (http://www.infineon.com/imotion-software). All supported tools and software
variants are listed there. Please visit this page periodically to check for tool/software updates.

The isolated on-board debugger provides the USB-to-UART bridge between the PC and the target iIMOTION™
device with 1 kV DC galvanic isolation between the motor drive system (hot side) and the PC/debugger (cold)
side. The on-board debugger uses the SEGGER J-Link driver for UART communication with IMC101T-T038. The
J-Link driver will be installed during the MCEDesigner installation. In case the driver is not installed properly,
please go to the SEGGER J-Link website to download and install the latest J-Link “Software and Documentation
pack for Windows.”

2.1.3 MCEWizard setup overview

Double-click the shortcut to open the MCEWizard and configure the parameters for evaluation boards or motor.
Figure 4 shows the “Welcome Page” for MCEWizard, where the MADK control board or power board can be
selected from the pull-down list. Infineon continues to release new MADK controller and power boards.
Therefore, it is possible that some of the latest power boards have not been pre-configured in the MCEWizard
tool and cannot be selected from the pull-down menu. In that case, the user should select another power board
(as similar as possible) and follow the MCEWizard setup steps by entering the parameter values that are specific
to the chosen board. Make sure both “I have modified the circuit board” and “Enable advanced question”
checkmarks are selected. Please refer to the Application Note of the corresponding power board for additional
information.

After selecting the MADK control and the power board, start the MCEWizard system setup procedure by clicking
the “Next” button in the right bottom corner as shown in Figure 4.
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(infineon

ﬁ MCEWizard 2.3.0.0 - C\W-project\IM828\Drive wized\20200821-8k.mc2

File JumptcPage Help

Welcome Page

iMOTION™ 2.0 System Configuration Wizard

Previous

Get MADK Hardware Info Get iIMOTION™ Info

MNext

Figure 4 Welcome page of MCEWizard

The iIMOTION™ MADK system enables users to easily test different combinations of control and power boards
with their motors. Users should be familiar with the system level parameters that are related to the motor used.
There is a very limited number of parameters which are specific to the control board or power board hardware.
Table 3 provides the MCEWizard setup overview for hardware related parameters specific to EVAL-M1-IM828-A
power board. Similar tables will be available in each control board’s Application Note. A combination of this
table and the corresponding table of the control board provides sufficient information to set up the MADK-

based motor drive system rapidly.

Table3 MCEWizard setup overview table

Parameter

Value

Control board selecting

EVAL-M1-101T for example

Power board selecting

EVAL-M1-IM828-A

Motor 1 shunt configuration Single shunt
Controller supply voltage +3.3V

Max DC bus voltage 780V

DC bus sensing high resistor 5000 kQ

DC bus sensing low resistor

Refer to the control board’s user guide

NTC temperature shutdown value

Refer to the control board’s user guide

GateSense low-side devices

High is true

GateSense high-side devices

High is true

Motor 1 current input

Calculated in the corresponding section in control
board’s user guide. For current feedback setup, please
see “3.6 Current feedback to control board”.

User guide
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After all the MCEWizard questions are answered, the “Verify & Save Page” will be shown as in Figure 5.

MCEWizard 2.3.0.0 - CAW-project\M228\Drive wized\20200821-Ek.me2 - 1 X

File JumptoPage Help

% |

[Verify & Save Page

Verify Parameters

|calcutate Parameters Display Parameters Results Export to MCEDesigner File (.b<)|

Double-Click an item to JUMP to its associated question

Figure 5 Verify and save page of the MCEWizard

Click “Calculate Parameters” button and “Export to Designer File (.txt)” button to save the parameter file which
will be used by the MCEDesigner in the next steps.
2.1.4 MCEDesigner setup overview

After installing MCEDesigner, there is a shortcut for the MCEDesigner on Windows desktop. Double-click the
shortcut to open MCEDesigner and then open “IMC101T_xx.irc” file as shown in Figure 6.

R System - 202003004 irc - Infinean Technalegics - MCEDesigner Ver 2.1, 2.0
L
___________ = Motor! 20000 EiE
H praje rice wizedc Wy CW- arcject IME20Drive wiaed'
| B3 Menitar Definitians 1 il Register Structure Definitians
= Bl Functon Delinibarn:
15 4 Sunfunction Library Definition
Forblelppressil [MCIOIT @ COMSUp  Tigldle | MewriSop | [ |/ ‘Stc Locked - SoiptDssoled
Figure 6 MCEDesigner main display for EVAL-M1-101T
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Figure 7 Program IMC controller” pop-up window

After the drive system parameter file has been programmed into the IMC101 controller, and the motor drive
system is powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change
the motor speed, modify drive parameters and many other functions. Please refer to the MCEDesigner
documentation for more details.

Note: The on-board debugger section of the EVAL-M1-101T has galvanic isolation from the controller
section and the attached power board. In order to program the parameters or firmware to the
IMC101T-T038 controller, the 3.3 V DC voltage needs to be supplied to the controller section of the
EVAL-M1-101T. This voltage can either be supplied by the power board (MADK power boards are
designed to supply the 3.3V to the control board via M1 or M3 connector) or by feeding the 3.3 V
voltage to the control board via some of the available 3.3 V access/test points if the power board is
not attached to the EVAL-M1-101T control board.

To program new firmware and the drive system parameters into IMC101T-T038, please click the “Tools” menu
and select “Programmer” in the pull-down list. The pop-up window “Program IMC controller” will show up as
in Figure 8. Click on the “Program Firmware and Parameter” radio button, and select the “Drive System
Parameter” file created using MCEWizard by clicking on the “Browse” button on the row of “Program Parameter
File”, and then select the firmware file by clicking on the “Browse” button in the row of “Program Firmware
File.” Finally, click on the “Start” button to program the parameter file into the IMC101T-T038 IC.
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Figure 8 Program firmware and parameter in “Program IMC controller” pop-up window
.
2.2 The current waveform from MCEDesigner

MCEDesigner has a parameter trace function for debugging and checking the PCB layout/parameter settings in
the “.irc” window.
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Figure 9 Trace function in MCEDesigner window

The trace function shows what the MCE “saw.” The figures below are the motor current waveform at stop and
running status.
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This is typical current waveform of a sinusoidal brushless motor driven by the EVAL-M1-IM828-A and EVAL-M1-

101T with iMOTION™ software.
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2.3 Description of the functional blocks

The motor inverter of EVAL-M1-IM828-A reference design is implemented by the IM828-XCC module, and the
auxiliary power supply is based on quasi-resonant controller: ICESQSAG and CoolSiC™ MOSFET
IMBF170R1KOM1.

2.3.1 Overview of IM828-XCC

Figure 12 provides the overview of the IM828-XCC internal electrical schematics. For further information
regarding these CIPOS™ SiC IPMs such as static and dynamic electrical behavior, as well as thermal and
mechanical characteristics, please refer to the datasheet of the IM828-XCC.

P (24)
(1) vs(u) ‘
(2) VB(U) VBI? HO1 ‘
RBS1 VSi ° U (23)
(3) VS(V) E(—
(4) VB(V) VB2 HO2
RJ VS2 ' vV (22)
e SR
(6) VB(W) VB3 HO3
RBS% VS3 ‘ W (21)
>
(7) HIN(U) HIN1 LO1 ﬁ}
(8) HIN(V) HIN2 NU (20)
(9) HIN(W) HIN3
(10) LIN(U) LIN1
(11) LIN(V) LIN2 LO2
(12) LIN(W) LIN3 NV (19)
(13) VDD VDD —
(14) RFE RFE
(15) ITRIP ITRIP Lo3
(16) VSS VSS NW (18)
(17) VTH \
Thermistor
Figure 12 IM828-XCC internal electrical schematic

The main features of CIPOS™ Maxi IPM IM828-XCC include:

e 1200V CoolSiC™MOSFETs

e Maximum blocking voltage VCES = 1200 V

e Maximum output current at 25°C case temperature I =35 A

e Rugged 1200V SOI gate driver technology with stability against transient and negative voltage
e Allowable negative Vs potential up to -11 V for signal transmission at Ves =15V
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e Integrated bootstrap functionality

e Over-current shutdown

e Built-in NTC thermistor for temperature monitoring
e Under-voltage lockout at all channels

e Low side emitter pins accessible

e Forall phase current monitoring (open emitter)

e Cross-conduction prevention

o All of 6 switches turn off during protection

e Programmable fault clear timing and enable input
e Lead-free terminal plating; RoHS compliant

(infineon

Table 4 Absolute maximum ratings of IM828-XCC
Symbol Description Min Max Unit
Vs MOSFET drain-to-source voltage -- 1200 v
Ip DC drain current Tc=25°C, T,<150°C -- 35 A
Tc=80°C, T, <150°C -- 20 A
Pd Maximum power dissipation per MOSFET -- 86 W
T, (MOSFET & Operating junction temperature -40 150 °C
IC)
Ts Storage temperature range -40 125 °C
Vs High side floating supply voltage -1 20 v
Vs High side floating supply offset voltage -- 1200 v
Voo Module control supply voltage -1 20 v
Vin Input voltage ( LIN, HIN, REF ) -1 Voo + 0.3 V
Vrru Repetitive peak reverse voltage of bootstrap -- 1200 v
diode
2.3.2 Overview of IMBF170R1KOM1

The IMBF170R1KOM1 is Infineon’s CoolSiC™ 1700V SiC Trench MOSFET, offers high performance, high efficiency
and easy to use with DC 120~1000 V full voltage range safe industrial auxiliary power supply for fly-back

topology.
This is the MOSFET package and definition:
Drain

Gate

pinl

Sense Source

pin2 pin 3-7 '
Figure 13 IMBF170R1KOM1 package: PG-T0263-7 and pin definition
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The main features of CoolSiC™ MOSFET IMBF170R1KOM1 include:

1700V CoolSiC™ MOSFET

Revolutionary semiconductor material - Silicon Carbide

Optimized for fly-back topologies

12V/0V gate-source voltage compatible with most fly-back controllers
Very low switching losses

Benchmark gate threshold voltage, Vesin) = 4.5V

Fully controllable dV/dt for EMI optimization

(infineon

Table 5 Absolute maximum ratings of IMBF170R1KOM1
Symbol Description Value Unit
Vbs MOSFET drain-to-source voltage 1700 v
Ip DC drain current Tc=25°C 5.2 A
Tc=100°C 3.7 A
Ptot Power dissipation, | Tc=25°C 68 W
limited by Tjmax Tc=100°C 34 W
Ip.pulse Pulsed drain current, t, limited by Tyjmax, Ves=12V | 13.3 A
Ty Virtual junction temperature -55~175 °C
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3 System design

The EVAL-M1-IM828-A board is an optimized design for 3-phase AC 380V major home and industry appliances.
To meet individual customer’s requirements and to make the EVAL-M1-IM828-A reference design a basis for
development or modification, all board design data such as schematics, Gerber and Altium design data can be
found on the Infineon homepage and log in your account to download them.

3.1 Inverter section using CIPOS™ Maxi

The inverter section isimplemented using the CIPOS™ Maxi as sketched in Figure 14. This is 3-phase inverter
bridge section with Infineon CoolSiC™ SiC MOSFET and driver inside. RS1/RS2 are single shunt for current
sensing. The three capacitors C10,C11 and C12 are used as bootstrap capacitors to provide the necessary
floating supply voltages VBU, VBV and VBW respectively. C24 is a DC bus snubber for IPM.

o w |
e |
"'—|'—zzur""' I iriaa R
o |
1

N
22 L

'ZZZT3.2“.T‘.ZZZZZ ""l%%ﬁﬁﬁjﬁﬁﬁﬁ
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e e I ownivi 7l

5002 “TVvH[ ~] PWMVH 8 —”«g‘*
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Figure 14 The diagram of the inverter section

3.2 DC/DC

Figure 15 depicts the schematic of the power supply available on the EVAL-M1-IM828-A board. The circuit is ZVS
fly-back topology; the input voltage range is 150~780 V DC bus, and the discharge DC bus is go to lower than 60
Vin 180 seconds (by K1 and fan) when power is turned off. It includes the ICESQSAG and CoolSiC™ 1700V SiC
trench MOSFET used to generate 15V and 6 V directly from the DC bus. 15V is connected to the gate drivers
inside the CIPOS™ Maxi IPM, which generates 12V for K1 and fan. 3.3 V power supply is from DC6 V by linear
regulator IFX25001ME V33. The 3.3V power supply is used in the over-current comparator circuit. Both 15V and
3.3V are also present on the 20-pin interface connector J3.

User guide 18 of 39 V1.0
2020-10-09



o~ _.
EVAL-M1-IM828-A user guide Infineon
Modular application design kit (MADK) of IM828-XCC

System design
Lo . FAN-12Y .
~ Fam12v o T BRI 38R o
14 TPS 15V1
| At .
b - - . ]
1 C45
a—ﬁqmupm
. s oo as e one o TH - TE v o o o &y -
_BL5 o USIM- E’\ ﬁlT USIN-E3/61T 1
F T o i L oA 2L o 2
R10 Rll1
R13[JR14 1 ™ N 1
opf | povg| 200kCIE 200k o
CPveEd D MR 1
1—
I\IBFl"[)RlI\UMl

;[]P;Hm[];z. =1 [

L RIS 43R C42 . TI0aF 16V]
3MEG 10R] - - &1+ OPEN 1 -] | | EE20000 | 10uF 25V 2l oo e - GhD2
. i R e — . A1 ca L -
- I TFX25001ME V33 ha
[]RD [ A . o %’1.91_-_. oo e 15Vl . .. o501
IMEG 3 &
D 5002 U4
3, NetC34.1.| 2 P S r——
o . C :| :SE A
) E 'z = * E
e ——T []R19 || - pesme
ol Thees i N ‘i" i E10 SN
DN [Rs  esaleder] £y |
N 1 R — = - P
3 3%, 62k 7= TL431CDBZR T
TOURF TZ0pFITTiE =
W
ZCD .
5002

Figure 15 DC/DC power supply

Koo

'CH1: Q1 Drain

10.0s

g+~ 0.00000 s

Figure 16 Q1 ZVS switching and 15 V/3.3 V output at 430 VAC input
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3.3 AC/DC input and soft start

Figure 17 depicts the schematic of the AC/DC input section. It includes the connector J1, the rectifier (DB), soft
start (R2, K1), a passive EMI filter (C1, C2, L1, L2), a fuse F1 for over-current protection, and DC bus capacitors
(Ce,C7,C8,C9).

DCBUS
TPS
K1 ﬁ
15\-’1?{/\/\ [9GV1L14-12
27 0aW _I_
. E F1
| = | ZTPV-25 3041000V 5 ks R3
OE 3 RZ 1, b =
T onsoan 7= ||
Tl 104-1500v| < | =
= =4 =1
o+ = c1 ; w2 | 2
P4 4 3 2200pF 4KV =
213 - co P, v oo Ul I
Z
g_l ; * * 2200pF 4kv L} 27l 0l 18 L& 9 g
L | . 2 A
CON-5PIN 104 1600% e 2
GUO4D-12NO1 [ - ERmEy =
TRS1 e | & 1
D: xr A b o
Figure 17 The schematic of AC/DC section and soft start circuit
3.4 DC-link voltage measurement

Pin 14 of connector J3 provides access to the DC-link voltage.

5 .

IMEG

= ;

IMEG

_’.‘ b

IMEG

e 0 T RE:

DCBSENSE — —
IMEG . IMEG

Figure 18 DC bus sensing

R45 is the safety resistor on the connection port when the connector is open. The DC-bus sensing low-side
resistance is R45//R1 (R1is on EVAL-M1-101T). Itis 1 MQ//13.3 kQ =13.13 kQ
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3.5

Current sensing and amplifier

(infineon

EVAL-M1-IM828-A has single shunt sensing by RS1//RS2. The final value of shunt resistance is 5 mQ. The current

output U+ goes to J3.

.C_:}I,:Ir‘]upl‘.. FE Y
JR2g L asbE
B Y o
us R30 47R R46
R I R R L
L . o o o /+3 L A R2S 47| - S 47R | | - - - F
TU+ .:)_ U+ B3l . = T o | c29 2 | c26 _lcas TR26F RS2 RS1 .
5002 I oo~ e o 1opEN x| ToPENTR e Ll - Lle
] . B . . o] - . B . . N . . _: e s 4 o — . .\C = b
S - TR _ TR L ~ [5011
= o 43| c44 - - = o -
R49 = =
Lt T 10F
Tak | .'LnF. nk. ..
a1
]
—F
" 10pF COG
Figure 19 Current sensing and signal amplification

R29 /R33 /R46 /R47 / C25/C26 / C29 are for low-pass filter (LPF) for EMC noise from shunt resistor. R30 / R32 /

R49 / C41 and U5 consist of a low-noise proportional amplifier. The gain of the amplifier is:

R49

~ 13.26

Gain =

R32 + R33 + R47

The current scaling is:

v _ RS1XRS2
shunt = pg1 + RS2

Static status:

X Gain = 66.3 mV/A

_ R27x33V 0.6V
°  R27+R28
The response time:
To =~ W =0.15 LlS
Gain—1

R31is U5 output transmission matching resistor. GBW is the gain bandwidth of U5.

3.6

Current feedback to the control board

The circuit below shows the feedback current signal to the control board. The offset circuit consists of R6 and

3.3Vonthe EVAL-M1-101T.
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J3

EVAL-M1-IM828-A

+3.3V

EVAL-M1-101T

R31
w+ —d 1 [U/MCE
100 2k 100
1D
220pF

iIND

Figure 20

~ R6
“TR6 +R21 + R27

= 0.826

Total gain to IU input:

2G = a X Gain = 10.96

Total current scaling to IU input:

Vehuntz = R16 X ZG = 54.8 mV/A

Current signal transmission between EVAL-M1-IM828-A and EVAL-M1-101T

The attenuation of the current signal from [U+ to J3 (Pin 10 [U+):

Motor 1 Current Feedback and Sample Timing

Question 83 - Motor 1 Current Input Scaling

This parameter is the gain of the external current singlefleg |
shunt measurement circuit.

This value is the product of the shunt resistance in milliohms
and the ac gain of the offset and gain circuit:

G_ext xR_s. 1y " iE
| el
In the circuit example, the gain calculated from analysis with el “_Ir-. i
Rs~0, is given by: oac| !

G_ext = R2 /(R1 + R2).

The input filter capacitor; C1, should be selected so that the
offset and gain circuit time constant is less than 400ns to

Expand Picture

Oftsct & pain drouit

% F]‘F Vil}

|
Var = Ging ':Vcnr' Gy % Re k) |
Vin= Ve = Grey £ Raat g

T i : wrn — —+3017
minimize the impact on current sampling. v 2
AE 3 .
. % iy '3=|sx Qa
. i : : : VoD
High current applications may require an active offset and gain : L 10,” s
i i i

circuit to support low resistance shunts or to improve the
measurement signal to noise ratio.

Answer: |

54.8| mV/A

Figure 21

User guide

Current input scaling setup with MCEWizard
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The current offset to IU input:

v (3.3V—10.6V) x (R21 + R27)
offset = R6 + R21 + R27

+06V=107V

Since control board ADC range is 3.3V, we have to select the internal gain of control board to “1”.

Motor 1 Current Feedback and Sample Timing

Question 84 - Internal Current Feedback Amplifier Gain Expand Picture

This parameter is the gain set for the programmable gain R
= aln @rcul
amplifier between the current sense pin and the ADC. st VoD &
D o

This parameter is the gain set for the programmable gain
amplifier between the current sense pin and the ADC.

The available gain values are 1, 3, 6 and 12. The net gain
provided by the internal and external amplifiers determines the
current feedback range: 1 range = (VDD/2)/(G_int X G_ext X
R s}

The product of the gain and the voltage offset (V_off) should be

Vg, = Gt (Vo= GoeX Rek Iy
50% of VDD to ensure current sensing is centered around zero. e b e ek}

i
wnn oy Yn= ¥en+ Bep k Red s

An amplifier gain greater than 1 supporis the use of low VEDV": as Yo - V=X R,
resistance shunts to minimize the shunt power loss and size. It o | t s ”l_""" =Jr o
e P L T TN

also allows setting the overcurrent comparator level outside the L S P S . | —
current measurement range and maximize the use of the ADC i1 T

measuremeant range. Lok
Answer: | ¥ -.,|
Figure 22 Current feedback amplifier gain setup with MCEWizard.
User guide 23 0f39 V1.0

2020-10-09



o _.
EVAL-M1-IM828-A user guide Infineon
Modular application design kit (MADK) of IM828-XCC

System design

3.7 ITRIP and GK setup
3.7.1 ITRIP setup
U
- LMV793ME
. : R "R31.
10U+ IU+
5002 o
B “10pF COG
Figure 23 Over-current protection circuit and ITRIP signal

IM828-XCC provides an over-current detection function by connecting the ITRIP input with the MOSFET drain
current feedback. The ITRIP comparator threshold (typ. 0.5 V) is referenced to VSS ground.

The typical over-current threshold (IOCP) is:

0.5V X (R34 +R48)
R48

Vshuntl

Vo

[IOCP = =34A
When the current is higher than 34 A, it will generate a shutdown for all outputs of the gate driver. The
shutdown propagation delay is typically 1 ps.

3.7.2 PWM shut down and GK output

When over-current is detected, the ITRIP voltage is over the threshold value, then C30 will be discharged (GK is
open drain), and GK drops to “0”. This GK sends signal to control board via J3. GK “0” status is continuous for

about 150 ps. After 150 ps, GK becomes open drain and charges C30 via R20. The R20 and C30 time constant is
about 470 ps.Figure 24 shows the ITRIP and GK circuit. Figure 25 shows the over-current protection waveform.

To J3
3.3V R20 13
M: . GK 14| RFE
—— [TRIP 15 B
1 C30 16/vss
T 4mFC0G [
17 -
ot - V828
Figure 24 ITRIP / GK and fault-clear
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CH1 (Yellow ) :GK |

CH4 ( Green ) : U output

M ,N-—-—-m

CH3 ( Purple ) : Short current}

l‘-mous H:oo C
i+v-40.0000ns Jl10M 5
Figure 25 GK and U phase current and voltage waveform in short output on J2
3.8 NTC thermistor characteristics and over-heat protection calculation

Figure 26 shows the NTC measurement circuit.

EVAL-M1-101T J3 EVAL-M1-IM828-A
| 133
|
|
| 16
| R2
| VIH 487k 1% VIH 17 %
T L
! Ten ,
| o, IMS28
|
|
. R
P S L e s sV RO |

Figure 26 NTC (inside IM828-XCC) connect to EVAL-M1-101T via J3

The NTCis 85 kQ @ Tnrc=25°C, B-constant = 4092 K:
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Figure 27 NTC temperature curve and table

Table 6 VTH output vs NTC to EVAL-M1-101T:
Temperature (°C) NTC (kQ) VTH (V)
50 29.97 2.839
60 20.51 2.667
70 14.31 2.462
80 10.16 2.231
90 7.345 1.984
100 5.388 1.733
110 4.009 1.490
120 3.024 1.264
125 2.639 1.160

Figure 28 shows curve of VTH vs NTC
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Figure 28 VTH output

Motor 1 Fault Conditions
Question 67 - NTC Temperature Shutdown Value Expand Pictura

Set voltage value for NTC Temperature Shutdown if Over
Temperature Shutdown is enabled.

If Over Temperature Shutdown is enabled and voltage at AIN
pin for NTC is below this value, motor will stop and enter fault
state

A |

MazorLim

IdFwk{manx)

RegenLim

Tsutdawn

Answer: | 1.}'8|| v

Figure 29 IPM temperature shutdown set to 100°C in MCEWizard
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3.9 Layout

This board has two electrical layers with 70 um copper (2 oz. copper) and dimensions are 140 mm x 151 mm.
The thickness of the PCB board is 1.6 mm. Figure 30 and Figure 31 illustrate the top and bottom layers of the

reference design.

Figure 30 Top layer
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Figure 31 Bottom layer

JUserguide 290f30 V1,
0000000000



EVAL-M1-1M828-A user guide
Modular application design kit (MADK) of IM828-XCC

(infineon

System design

HS . Fi

Hidd3
=T

&
&

T Hs o
: :l: _’: T L M I:‘% (= =20
L m@@@ @@? ® LU - )= 2
13 ® @meEE®" ] .
i * e eene o e o S
uel ® s esoeee o 8 ®
ee ® i
ee 00 iz .
e @
esl ° ®
®lae 4
Ll |
L] l
L ] l l
B » @
01—|i! ﬁ
_ o3 ' . ’
ml:vm ... a
JZ EUAL-M1-IM828-A U1L.0
=1 — = w0 2020-08-05
Il U u
Figure 32 Top over layer
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Figure 33 Bottom over layer

3.10 Bill of material

Table 7 shows the major parts of EVAL-M1-IM828-A design.

The complete bill of material is available on the download section of the Infineon homepage. A log-in is
required to download this material.

Table7 BOM of the most important/critical parts of the evaluation board
S. No. Ref Designator Description Manufacturer Manufacturer P/N
1 u3 CoolSiC™IPM Infineon IM828-XCC
Technologies
2 Q1 CoolSiC™ SiC MOSFET 1700V | Infineon IMBF170R1KOM1
Technologies
3 U2 Quasi-resonant PWM Infineon ICE5QSAG
controller Technologies
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4 ul Low dropout voltage Infineon IFX25001ME V33
regulator, 3.3V output Technologies

5 Ce6,C7,C8,C9 Electrolytic capacitor Wurth Elektronik | 861011486024

6 C13 Electrolytic capacitor Wurth Elektronik | 860020474014

7 C15,C45 High endurance radial leaded | Wurth Elektronik | 860020474012
aluminum electrolytic
capacitor

8 Ci1e6 High endurance radial leaded | Wurth Elektronik | 860080374009
aluminum electrolytic
capacitor

9 c23 Miniature aluminum Wurth Elektronik | 860080472002
electrolytic capacitor

10 J1 5-pin Wurth Elektronik | 691210910005

11 J2 Connector Wurth Elektronik | 691250910003

12 J3 Connector Wurth Elektronik | 613020243121

13 L1, L2 WE-CMB HV common mode Wurth Elektronik | 744830007215/ARCD

/sunlord C432340A701N2B

14 L3, L4 WE-CMB HV common mode Wurth Elektronik | 744232261

15 TR1 EE20/10/6 Wurth Elektronik | 750344164

3.11 Connector details

General information about the connectors of the EVAL-M1-IM828-A evaluation board is provided in the tables
below. Table 8 includes the details of the 3-phase AC or DC input connector J1. Table 9 provides the details of
the motor side connector J2. Table 10 provides the pin assignments of the IMOTION™ MADK M1 20-pin interface

connector J3. This connector is the interface to the control board.

Table 8 J1- 3-phase AC or DC input connector
Pin # Pin name Description
1 EARTH Earth
2 NC No connection
3 AC/DC input
4 B AC/DC input
5 AC/DC input
Table9 J2- Motor side connector
Pin # Pin name Description
1 U Connected to motor phase U
2 v Connected to motor phase V
3 W Connected to motor phase W
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Table 10 J3-iMOTION™MADK M1 20-pin interface connector for power board
Pin # Pin name Description
1 PWMUH 3.3V compatible logic input for high-side gate driver-Phase U
2 GND Ground
3 PWMUL 3.3V compatible logic input for low-side gate driver-Phase U
4 GND Ground
5 PWMVH 3.3V compatible logic input for high-side gate driver-Phase V
6 +3.3V 3.3V power supply
7 PWMVL 3.3V compatible logic input for low-side gate driver-Phase V
8 +3.3V 3.3V power supply
9 PWMWH 3.3V compatible logic input for high-side gate driver-Phase W
10 U+ Shunt voltage+
11 PWMWL 3.3V compatible logic input for low-side gate driver-Phase W
12 IU- Ground
13 GK Gatekill
14 DCBSENSE Input, DC bus voltage to AIN1 after 2000 kQ registers
15 VTH Input, voltage input of power module’s temperature sense
16 IV+ Open
17 V- Open
18 IW+ Open
19 IW- Open
20 vcC Defined for 15V power supply
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4 System performance

4.1 Type output waveform at 3-phase AC380 V input

_JELT | U

10.0 A

Figure 34 ly Output 18.35 A at PWM=6 kHz waveform by DP04104(oscilloscope) + TCP0030(probe)

=}

| ‘ SME
| @D E[E 3.499 A 3.397 64.67m  15.92

Figure 35 ly Output 3.5 A at PWM=6 kHz waveform by DP04104(oscilloscope) + TCP0030(probe)
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4.2 Test results for over-current protection

Figure 36 is the EVAL-M1-IM828-A over-current detection function by connecting the ITRIP input with the IM828-
XCC current feedback, and CoolSiC™ MOSFET short-circuit withstand time is about 1.8 ps. Over current
detection generates a shutdown of outputs of the gate driver if ITRIP pin input is over 525 mV and lasts longer
than 500 ns.

) Moops /s
: Iﬁ —40.0000ns | ‘,_I

Figure 36 Over-current protection response waveform (CH3: over-current CH4: output voltage)

4.3 Temaxi VS lout at different PWM frequencies
Figure 37 shows the IPM case temperature vs output current with difference PWM carrier frequencies.
Tcmaxi vs output @ different PWM frequency
120
110
100
g 90
<80
1
£ 70
§ €0 ——PWM =6 kHz
£ 50 ——PWM=12kHz
40 PWM =24 kHz
30 ——PWM=40kHz
20
0 5 10 15 20 25
Output (A)
Figure 37 IM828-XCC case temperature vs output power current at different PWM frequencies @380
VACinput, T.=25C
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4.4 IM828-XCC’s efficiency
Figure 38 shows the IPM efficiency vs output current at 380 V AC input and 6 kHz carrier frequency
IPM efficiency on board @ AC380 V input AC345V output PWM =6 kHz
100
99.8
99.6
994
< 992
9
g 9
£ 988
=
& 986
98.4
98.2
98
0 2 4 6 8 10 12 14 16 18 20
Output current (A)
Figure 38 IM828-XCC efficiency vs output current @ 380 V AC input, output 342 V AC, 6 kHz
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5 References and appendices

5.1 Abbreviations and definitions
Table 11 Abbreviations

Abbreviation Meaning

MADK Modular application design kit

CE Conformité européenne

EMI Electromagnetic interference

UL Underwriters laboratories

OPA Operational amplifier

LPF Low-pass filter

5.2 References

[1] Infineon Technologies AG. Datasheet of Infineon IM828-XCC Datasheet (2020). V2.0 www.infineon.com

[2] Infineon Technologies AG. Datasheet of Infineon IMC101T Datasheet (2020). V1.6 https://infineon.com

5.3 Additional information

The power board is now available for customers in small order quantities. In order to initiate the testing,

customers are advised to order the following items:

Table 12 Ordering information
Part number Symbol Package Quantity
EVAL-M1-IM828-A Boxed 1
IM828-XCC u3 DIP 36x23D 1
ICE5QSAG u2 PG-DSO-8 1
IMBF170R1KOM1 Q1 PG-T0263-7 1
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